
 
 

 

 

 

 
 

Dokowanie molekularne przy użyciu AutoDock i 
AutoDockTools 

 

Opracował: Marcin Jaromin mjaromin@prz.edu.pl 
 

 
Potrzebne programy 

Najlepiej pobrać z naszego kursu e-learningowego, ale poniżej odnośniki do stron twórców 
oprogramowania.   

 
Program AutoDock należy pobrać ze strony: http://autodock.scripps.edu/downloads a 
następnie zainstalować go zgodnie z instrukcją 

 

Program ADT należy pobrać ze strony: 
http://autodock.scripps.edu/downloads/resources/adt/index_html a następnie 
zainstalować go zgodnie z instrukcją. 

 

https://www.youtube.com/watch?v=k6tqCeDIwEk 
 

Program Open Babel – konwersja plików chemicznych 

http://openbabel.org/wiki/Category:Installation 

Dokowanie molekularne jest najpopularniejszą metodą projektowania leków opartą na strukturze 
(SBDD, ang. structure-based drug design), czyli wtedy gdy znana jest dokładna struktura 3D celu 
molekularnego. Popularność przyniósł ogromny wzrost mocy obliczeniowej komputerów, który 
pozwolił na badanie powinowactwa (ang. affinity) wielu ligandów w krótkim czasie.  
 
Dokowanie typu mała cząsteczka – makrocząsteczka 
Mała cząsteczka nazywana jest ligandem i najczęściej jest nią substancja endogenna lub egzogenna 
(np. lek) o małej masie molekularnej.  
Natomiast makrocząsteczką może być białko (enzym, receptor), peptyd, kwas nukleinowy (DNA, 
RNA) lub inny biopolimer.  
 
Przykład: Dokowanie tamoksyfenu do białka 2FSZ (receptor estrogenu) 
 
Oryginalna praca naukowa 
Wang, Y., Chirgadze, N.Y., Briggs, S.L., Khan, S., Jensen, E.V., Burris, T.P.  
„A second binding site for hydroxytamoxifen within the coactivator-binding groove of estrogen 
receptor β”,(2006) Proc Natl Acad Sci U S A 103: 9908-9911 

mailto:mjaromin@prz.edu.pl
http://autodock.scripps.edu/downloads
http://autodock.scripps.edu/downloads/autodock-4-2-x-installation-on-windows/
http://autodock.scripps.edu/downloads/resources/adt/index_html
http://mgltools.scripps.edu/downloads/previous-releases/downloads/instructions/win
https://www.youtube.com/watch?v=k6tqCeDIwEk


DOI: https://doi.org/10.1073/pnas.0510596103  
Krótki opis wykonany przez studentów specjalności Biotechnologia w farmacji w ramach projektu 
(inż. Anna Nieczaj , inż. Oliwia Myszka, inż. Alicja Niemczyk, inż. Wojciech Jasionek) i moją skromną 
osobę. 
 
Receptor estrogenowy 
Budowa 
Receptor estrogenowy, podobnie jak inne receptory jądrowe, 
składa się z kilku części połączonych w jeden długi łańcuch. 
Na jednym końcu jest część, która wiąże się z hormonem. Ta 
struktura posiada związany estradiol, pokazany na fioletowo. 
Jest to połączenie z domeną wiążącą, która rozpoznaje 
specyficzne sekwencje DNA, pokazane tutaj na górze. 
Wreszcie, na końcu domeny wiążącej DNA znajduje się duża 
domena transaktywacyjna,która nie jest tu pokazana. 
Aktywuje ona polimerazę RNA, gdy receptor wiąże się z DNA. 
 
 
    
   Rys. 1 Receptor estrogenowy  

   związany z krótkim fragmentem DNA. 
 
 
 
Estrogen w walce z nowotworem 
 
Estrogen stymuluje komórki do wzrostu. Jest to niezbędne w okresie dojrzewania, ale także 
konieczne w dorosłym życiu. Na przykład, estrogen jest ważny w rozwoju kości, a niski poziom 
estrogenów 
może prowadzić do osteoporozy. Natomiast w przypadku raka, estrogen może wzmocnić 
nienaturalny wzrost i pogłębić chorobę. 

 
Lek tamoksyfen jest stosowany w leczeniu 
raka poprzez blokowanie działania 
estrogenów. Tamoksyfen jest małym lekiem, 
który naśladuje kształt estrogenu i wiąże się 
ściśle z receptorem estrogenowym. Kiedy 
się wiąże, zmienia kształt pętli 
sygnalizacyjnej na powierzchni receptora 
(pokolorowanej tutaj na zielono). Górna 
struktura pokazana tutaj, ma związany 
estradiol (estradiol nie jest widoczny na 
zdjęciu, ponieważ jest związany pod pętlą). 
Zwarta konformacja tej pętli stanowi część 
sygnału aktywacyjnego, który będzie 
stymulował prawidłowy wzrost. Niższa 
struktura, ma związany lek. Ponieważ lek 
jest większy od hormonu, zmusza pętlę 
aktywacyjną do wyjścia w nieaktywną 
konformację, blokując  

Rysunek 2. Domena wiążąca ligand receptora estrogenowego z 
estradiolem (góra) lub tamoksyfenem (dół).  

https://doi.org/10.1073/pnas.0510596103


Tamoksyfen (Tamoxifen)  jest niesteroidowym antyestrogenem stosowanym w leczeniu raka piersi z 
obecnością receptorów estrogenowych, a także w zapobieganiu zachorowalności na raka piersi w 
populacjach wysokiego ryzyka. Tamoksyfen stosuje się samodzielnie lub jako środek wspomagający 
 

 
Rysunek 3. Tamoksyfen – wzór strukturalny, struktura 3D oraz 
podstawowe identyfikatory chemiczne. 

 

CAS number 
10540-29-1 

InChI Key 
NKANXQFJJICGDU-QPLCGJKRSA-N 

InChI 
InChI=1S/C26H29NO/c1-4-25(21-11-7-5-8-12-21)26(22-13-9-6-10-14-22)23-15-17-24(18-16-
23)28-20-19-27(2)3/h5-18H,4,19-20H2,1-3H3/b26-25- 

IUPAC Name 
(2-{4-[(1Z)-1,2-diphenylbut-1-en-1-yl]phenoxy}ethyl)dimethylamine 

SMILES 
CC\C(=C(/C1=CC=CC=C1)C1=CC=C(OCCN(C)C)C=C1)C1=CC=CC=C1 

 

 

Krok 1 – Przygotowanie środowiska pracy 

1.1 Przygotować folder na dysku (ścieżka nie powinna zawierać spacji i dziwnych znaków) 

1.2 Do przygotowanego folderu skopiować pliki: 

a) autodock4.exe oraz autogrid4.exe – domyślnie zainstalowane w C:\Program Files 

(x86)\The Scripps Research Institute\Autodock\4.2.6 – folder utworzony przy instalcji programu 

AutoDock. 

b) AD4.1_bound.dat i AD4_parameters.dat – domyślnie zainstalowane w C:\Program 

Files (x86)\MGLTools-1.5.7\Lib\site-packages\AutoDockTools – folder utworzony podczas 

instalacji AutoDockTools ADT. 

c) Plik receptora (cel molekularny) w formacie PDB (w moim przypadku 2fzs.pdb) 



1.3 Uruchomić program AutoDockTools 

1.4 Ustawić domyślny folder na utworzony w punkcie 1.1  

File  Preferences  Set: 

 StartupDirectory – wklejamy ścieżkę do folderu utworzonego w 1.1 naciskamy Set, Make 

Default i Dismiss. 

 

 
Krok 2. Przygotowanie pliku koordynacyjnego PDBQT 

Rozszerzony typ formatu PDB jest wykorzystywany do przechowywania informacji o atomowych 

ładunkach cząstkowych i typach atomów. 

RECEPTOR 

2.1 Wczytanie receptora 

File  Read molecule 

2.2 Usunąć niepotrzebne element – zaznaczamy niepotrzebny fragment i Edit  Delete selected 

2.3 Usunąć wodę (jeśli występuje) 

Edit  Delete water 

2.4 Dodać polarne wodory 

Edit  Hydrogens  Add (Polar only) albo w Dasboard – prawy przycisk Add Polar 
hydrogens 

2.5 Sprawdzić czy nie brakuje atomów w 

cząsteczce Edit  Misc  Check for 

Missing Atoms 

2.6 Naprawić braki 

atomów 

Odznaczyć 

wszystko. 

Edit  Misc  Repair for Missing Atoms 

2.7 Usunąć heteroatomy (atomy obce) – kilka sposobów, ale najłatwiejszy to: 

Select → Select From String, naciskamy przyciskiem na pole Atom Sets (prawa strona, 4 od 
góry) i wybieramy hetatm następnie Add i Dismiss.  

       I usuwamy zaznaczone elementy jeżeli istnieją Edit  Delete selected 

2.8 Dodać ładunki cząstkowe 

Edit  Charges  Add Kollman charges 

2.9 Sprawdzić ładunek na atomach 

Edit  Charges  Check Totals on Residues 

Jeżeli pojawią się jakieś element w oknie naciskamy Spread Charge Deficit over all atoms in 

residue (rozdziel brakujący ładunek na wszystkie atomy w aminokwasie). 

2.10 Zapisać cząsteczkę jako PDBQT 

Grid  Macromolecule  Choose I wybieramy naszą cząsteczke następnie program będzie 

chciał ją zapisać w formacie pdbqt (np.receptor.pdbqt – potrzebne w 2.1). 

I zamykamy program AutoDockTools. 

 



Krok 3. Konwersja liganda do format PDBQT oraz ustalenie wiązań skrętnych 

LIGAND 

3.1 Pobrać (przygotować) strukturę w formacie MOL lub SDF 

3.2 Przekonwertować do formatu „pdbqt” przy użyciu programu OpenBabel (nie przez 

stronę internetową tylko poprzez program). 

Uruchomić program AutoDockTools 

3.3 Wczytanie 
liganda 

Ligand  Input 

3.4 Dodać polarne wodory 

Edit  Hydrogens  Add (Polar only) albo w Dashboard – prawy przycisk Add Polar 

hydrogens 

3.5 Określamy wiązania ruchome liganda 

Ligand – Torsion tree  Detect 

Root 

3.6 Ustawiamy liczbę wiązań 

Ligand – Torsion tree  Set Number of Torsions 

 

 
Krok 4. Obliczanie AutoGrid (siatki potencjałów) 

4.1 Wczytaj strukturę receptora i liganda w formacie 

PDBQT: Grid  Macromolecule  Open  

receptor.pdbqt 

Grid  Set Map Types  Choose Ligand  I wybieramy ligand (modyfikowany w punkcie 

3.6) 

 

4.2 Określ dla jakich typów atomów będą liczone siatki: Grid  Set Map Types  Directly 

Accept 

4.3 Zdefiniuj położenie i rozmiar siatki. 

(Miejsce wiązania ligandów w receptorach GPCR znajduje się we wnęce między helisami. 

Należy tak dobrać parametry siatki aby pokrywała ona całe miejsce wiążące receptora. Nie 

zapomnij zachować parametrów siatki w oknie Grid Options File → Close saving current) 

Grid  Grid Box 

4.4 Zachowaj plik GPF.gpf: 

Grid  Output  Save GPF  1.gpf (dodać ręcznie rozszerzenie pliku) 

4.5 Uruchom program AutoGrid: 

Run  Run AutoGrid  (określ katalog w którym znajdują się wszystkie pliki oraz katalog w 

którym został zainstalowany program AutoGrid4.exe) 

 



 
Krok 5. Symulacja dokowanie przy użyciu AutoDock 

 

Docking is carried out using one of several search methods. 

The most efficient method is a Lamarckian genetic algorithm (LGA), but traditional genetic 

algorithms and simulated annealing are also available. For typical systems, AutoDock is run 

several times to give several docked conformations, and analysis of the predicted energy and 

the consistency of results is combined to identify the best solution.  

Najefektywniejsze aktualnie modele dokowania oparte są o algorytmy genetyczne i w tym 

programie taki właśnie wykorzystamy - Lamarckian genetic algorithm 

więcej informacji: 

Fuhrmann J, Rurainski A, Lenhof HP, Neumann D. A new Lamarckian genetic algorithm for 

flexible ligand-receptor docking. J Comput Chem. 2010 Jul 15;31(9):1911-8. doi: 

10.1002/jcc.21478. PMID: 20082382.  

https://pubmed.ncbi.nlm.nih.gov/20082382/ 

Ustawianie parametrów algorytmu, między innymi ile konformacji ma być sprawdzane, 

odbywa się poprzez menu AutoDockTools Docking → Search Parameters → Genetic Algorithm 

 

5.1 Określ strukturę receptora: 

Docking  Macromolecule  Set Rigid Filename  receptor.pdbqt 

5.2  Określ strukturę 

liganda: Docking  

Choose  ligand 

5.3 Zapisz plik DPF.dpf: 
Docking  Output  Lamarckian GA  1.dpf (dodać ręcznie rozszerzenie pliku) 

5.4 Zadokuj ligand korzystając z procedury AutoDock: 

Run  Run AutoDock  (określ katalog w którym znajdują się wszystkie pliki oraz katalog w 

którym został zainstalowany program AutoDock4.exe) 

 

Krok 6. Analiza wyników 
 

AutoDockTools zawiera wiele metod analizy wyników symulacji dokowania. Poniżej 

przedstawiona jeden z elementów analizy.  

 

6.1  Porównanie energii poszczególnych konformacji.    

Otworzyć utworzony przez program plik 1.dlg (nazwa pliku jest taka pod warunkiem, że w 

punkcie 5 jako nazwa pliku podano 1.dpf) w notatniku i odszukać fragment RMSD TABLE.  



Jednym ze sposobów oceny, która konformacja jest najlepsza polega na porównaniu Energii 

(im mniejsza tym lepiej, w kolumnie Run mamy numer konformacji).    

 

6.2  Wizualizacja wyników w programie AutoDockTools. 

  ADT Analyze  Dockings  Open  1.dlg 

 ADT Analyze → Conformations  Play  
(aby było to lepiej widoczne to podczas wykonywania 6.1 program automatycznie otwiera kopię naszego 
ligandu i w programie Python Moloecule Viwer na wysokości tego ligandu wybrać trzecią kolumnę B lub 
czwartą a C aby był on wyświetlany jako sfery lub kulki rysunek poniżej czerwone kółka z lewej strony na 
wysokości tamoksyfen-2))  
W moim przypadku z 12 konformacji najlepsza, według tabeli z energią okazała się konformacja piąta 
(kolumna Run). Do wyświetlenia wybranej konformacji używa się panelu pokazanego na rysunku poniżej 
cząsteczki). 
 



 
 

Zadanie dla studentów  
Wykonać dokowania ligandu do białka (fragmentu białka) jak w powyższym przykładzie. Jako wynik 
pokazać tabele z energią poszczególnych konformacji (ilość konformacji domyślnie ustawiona w 
programie 10, nie trzeba nic ustawiać) oraz wizualizacje najlepszej konformacji ligandu w otoczeniu 
białka (pkt 6.1 i 6.2 w przykładzie). 
Jako sprawozdanie wysyłają Państwo plik w którym są podstawowe informacje (kto i kiedy wykonał, 
ligand i receptor (białko),  tabele z energią poszczególnych konformacji, wizualizacje najlepszej 
konformacji ligandu w otoczeniu białka (patrz zdanie powyżej) oraz plik z wynikami .dlg. 
 

Numer indeksu Ligand Białko / Fragment cząsteczki 

173711 Afimoxifene 

https://go.drugbank.com/drugs

/DB04468 

4J24 / A 

173776 Droloxifene 

https://go.drugbank.com/drugs

/DB15641 

4J24 / A 

173777 Toremifene 

https://go.drugbank.com/drugs

/DB00539 

4J24 / A 

173781 Ospemifene 

https://go.drugbank.com/drugs

/DB04938 

4J24 / A 



173782 
Fispemifene 

https://go.drugbank.com/drugs

/DB06640 

5TOA / B 

173783 Clomifene 

https://go.drugbank.com/drugs

/DB00882 

5TOA / B 

173788 Afimoxifene 

https://go.drugbank.com/drugs

/DB04468 

5TOA / F 

173789 Droloxifene 

https://go.drugbank.com/drugs

/DB15641 

5TOA / B 

173794 Toremifene 

https://go.drugbank.com/drugs

/DB00539 

5TOA / B 

173795 Ospemifene 

https://go.drugbank.com/drugs

/DB04938 

5TOA / B 

173809 
Fispemifene 

https://go.drugbank.com/drugs

/DB06640 

3OLS / B 

167185 Enclomiphene  

https://go.drugbank.com/drugs

/DB06735 

3OLS / B 

173825 Clomifene 

https://go.drugbank.com/drugs

/DB00882 

3OLS / B 

173832 Droloxifene 

https://go.drugbank.com/drugs

/DB15641 

3OLS / B 

173842 Chlorotrianisene  

https://go.drugbank.com/drugs

/DB06735 

3OLS / B 

 


